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L'apprentissage de fGIS est relativement facile. L'habileté pour employer le
programme, cependant, exigera de la pratique. Les liens suivants fournissent les
bases pour travailler avec fGIS.
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fGIS est conçu pour digitaliser efficacement les cartes d'emplacement requises par des
directeurs de ressource naturelle. Une analyse spatiale de base peut être accomplie avec
des fonctionnalités robustes de recherche et d'analyse de propriétés, et des cartes de
haute qualité peuvent être imprimées ou sauvegardées en tant qu'images numériques.
Avec fGIS, la création des données géographiques se traduit en localisation de points ou
dessin de lignes vectorielles et d'entités surfaciques à l'écran. Les photographies aériennes
et les données vectorielles préexistantes constituent généralement les fonds
cartographiques de référence. fGIS utilise également les données spatiales issues de
sources telles que les unités de GPS, le géocodage de fichiers plats, les scanners, la
télédétection, etc. qui sont dans les formats de vecteur et d'images supportés par le
programme.

Caractéristiques de fGIS

Autorisation
Freeware avec droits d'auteur (© université 2003 du Wisconsin)
Plateforme
Tout logiciel d'exploitation 32 bits de MS Windows (Windows 95/98/2000/NT/ME/XP)
Le produit est autonome. Aucun autre logiciel de SIG ou de DAO n'est exigé.
Conditions (Mémoire, Processeur)
Les mêmes que les conditions du logiciel d'exploitation de MS Windows (bien que
l'exécution soit plus souple avec au moins un processeur de 1 gigahertz et 256 Mo de
RAM)
Formats de fichiers supportés

Crée : Fichier-projets De TatukGIS (* ttkgp)

Formats vecteurs supportés Lu Ecrit

ESRI® SHP Oui Oui
DXF (CARTE® D'AutoCAD) Oui
MapInfo® MIF Oui
Couvertures SQL - format de TatukGIS Oui
ESRI® e00 Oui
TIGER2000/line Oui

 

Formats Images Supportés.
L'écriture inclut les fichiers associés de coordonnées.

Lu Ecrit

Tiff (non compressé) Oui Oui
Tiff, GeoTIFF (1, 4, 8 et 24-bit, non compressé, packbits, group4, LZW) Oui
BMP Oui Oui
Png Oui Oui
JPEG Oui Oui
ECW &ndash; ER Mapper® ECW Oui
SID - Lizardtech® MrSID Oui

BIL Oui

Information pour Contacts
 

Si vous avez des suggestions pour améliorer fGIS, envoyez vos commentaires à
digitalgrove@msn.com.

auteurs de fGIS :

• Brian Brown (Programmeur)
• Paul Pingrey

Commanditaire du projet de fGIS : Le Wisconsin DNR - Division de la sylviculture



  

Divers

Fichier language.ini

fGIS intègre un fichier "language.ini" (simple fichier texte modifiable) permettant de
traduire le logiciel dans d'autres langues que l'anglais. Ce fichier modifie seulement
l'interface propre à fGIS mais pas les messages propres au composant (TatukGIS DK) utilisé
pour son développement. Si vous souhaitez des modifications personnalisées vous devez
acheter le composant TatukGIS DK.
Les fichiers "language.ini" sont localisés dans le répertoire racine de fGIS. L'extension du
nom des différents fichiers indique le langage correspondant (par exemple, le fichier
français est language.ini.fr). Pour utiliser ces fichiers, il suffit de renommer le fichier
"language.ini" originel en "language.ini.bak" et de renommer le fichier que vous voulez
utilser en "language.ini"
Si vous voulez traduire le fichier "language.ini" dans votre langue vous pouvez utiliser cet
outil : "Translator" de Jernej Simoncic. Il permet l'affichage simultané du fichier originel
dans la partie gauche et de la traduction dans la partie droite.
Si vous créez un fichier "language.ini" dans votre langue envoyez nous une copie, s'il vous
plait.
Note : Le module Diagram Designer de Michael Vinther offre aussi des versions en différents
langages.
 



  

Guide Rapide

1. Pour commencer à employer fGIS, vous devez ouvrir un projet existant ou taper le
nom d'un nouveau projet de carte. (vous pouvez souhaiter maintenir tous vos
fichier-projets dans un dossier pour une consultation plus facile.) Cliquez sur
Carte/Nouveau projet dans la barre de menu (ou cliquez sur Carte/Ouvrir un
projet pour lancer un projet existant).

2. Nommez votre projet et sauvegardez le dans le répertoire de votre choix. Un fichier-
projet de fGIS sauvegarde :

• Une table des matières de tous les thèmes de votre carte avec le chemin où
les données sont stockées

• Les propriétés des thèmes que vous avez définis
• La dernière vue affichée à l'écran

3. Utilisez alors le bouton 'Ajouter un Thème' (+) et naviguez dans les répertoires
pour ouvrir des fichiers shapefiles, des photographies aériennes ou d'autres thèmes
ou couches de SIG. Vous pouvez ajouter un fichier par double-clic ou sélectionner
plusieurs fichiers vecteurs ou images dans un dossier en maintenant les touches
Shift ou Ctrl tout en cliquant sur les noms des fichiers. Référez vous au 'Guide
Rapide' pour plus d'informations.

4. Double-cliquez sur le nom d'un thème dans la légende pour accéder à la boîte de
dialogue des propriétés du thème et modifier son mode de représentation.

Avant que vous puissiez créer un nouveau thème d'entités (fichier shapefile), au moins un
thème préexistant (vecteur ou image) doit être ajoutée dans la vue. FGIS utilisera ce
premier thème pour dimensionner votre espace.
Pour en apprendre plus sur un menu ou un outil particulier, cliquez l'objet dans
l'hyperimage suivante :



  

Fonctions des Menus

Menu Carte:

• Nouveau/Ouvrir un Projet : Sélectionnez un fichier-projet existant ou saisissez un
nouveau nom de fichier de projet. Avant que vous puissiez créer un nouveau thème,
au moins une couche préexistante (vecteur ou image) doit être ajoutée à la vue.
FGIS utilisera ce premier thème pour dimensionner votre espace. Si vous modifiez
un projet mais ne voulez pas écraser l'original, utilisez alors "Enregistrer le Projet
sous" et donnez-lui un nouveau nom. Quand vous rouvrez un projet, fGIS réaffichera
la dernière vue que vous avez sauvegardée.
Le fichier "projet" :

• est sauvegardé avec l'extension ".ttkgp", il peut être édité avec le viewer
TatukGIS® ou tout autre produit utilisant le noyau TatukGIS® DK. De plus le
fichier ".ttkgp" créé est un fichier texte structuré modifiable avec un éditeur
de texte (notepad, wordpad...).

• mémorise le chemin des couches ajoutées en relatif. Ceci peut être utile pour
échanger le projet, sur CD ou en fichier compressé, avec d'autres utilisateurs.
Il suffit d'inclure tous les fichiers de données géographiques dans un
répertoire en respectant la même arborescence.

• sauvegarde aussi les propriétés d'affichage des couches (couleurs,
étiquettes,formes...), l'échelle de la dernière vue et la visibilité des couches.

Il convient d'utiliser le même système de coordonnées pour toutes les couches que
vous ajoutez afin de les superposer.



• Zoom à l'échelle définit l'échelle de la vue à l'écran. L'échelle d'une carte imprimée
est définie par la fonction d'impression de la barre d'outils. 

• Ajouter/Supprimer un thème, Afficher/Masquer tout, indiquer tous les
thèmes :

• les couches peuvent être ajoutées ou supprimées à l'aide de ces commandes

ou du bouton sur la barre d'outil.
• l'option "Masquer Tout" est particulièrement utile quand vous voulez

afficher sélectivement différentes couches en arrière-plan pour l'analyse ou
l'impression.

• la fonction "indiquer tous les thèmes" permet de faire apparaître, dans la
légende, toutes les couches présentes dans le projet même celles dont le nom
a été caché.

• La recherche permet de mettre en évidence et sélectionner les objets vectoriels
d'un projet qui contiennent les données d'attribut correspondant aux critères de
recherche. Le bouton 'Sélection' de la boîte de dialogue de recherche permet aux
utilisateurs de sélectionner directement des entités en fonction de requêtes plutôt
qu'interactivement sur la carte. Les utilisateurs peuvent alors visualiser les attributs
des entités sélectionnées grâce à la boîte de dialogue 'Ouvrir la table du fichier
Shapefile'.

Cliquer sur le bouton "Ajouter" afin d'inscrire vos critères de recherche dans la zone
de "Requête".

• Les commandes de "sélection spatiale" permettentde sélectionner les objets en
fonction de leurs relations spatiales. Ce panneau permet par exemple de choisir
toutes les entités d'un thème qui sont contenues dans un périmètre de 50 mètres
des entités sélectionnées d'un autre thème :

• La commande "Unités de projection du Thème"' possède deux options : les mètres
et les pieds. Les nouveaux projets seront en mètres par défaut. Cette configuration
affectera seulement les mesures de distance et les calculs de surface.



• La commande "Unité d'échelle" permet aux utilisateurs de changer les unités d'échelle

en pieds ou en mètres
La valeur " pieds " est placée par défaut.

• Couleur de fond : par défaut la couleur de fond est le blanc.
• L'indexation 'R-Tree' améliore la manipulation de grands fichiers de vecteur et de

leurs bases de données associées. Cette fonction peut entrainer un délai d'attente du à
la création du fichier index. Cette commande est désactivée par défaut.

• Carte de localisation : cette commande ouvre une fenêtre. Faites un clic droit avec
votre souris à l'intérieur de la fenêtre afin d'ajouter un thème permettant une
localisation sur la vue d'ensemble.
Le menu contextuel du clic droit permet également de changer la couleur de la sélection
dans la fenêtre de localisation.
Si vous effectuez un clic gauche en vous déplaçant dans la "carte de localisation" vous
pourrez changer la zone d'affichage de la vue principale.
Le contenu de la 'carte de localisation' est sauvegardé dans le projet. Cette carte de
localisation peut être utilisée dans les fichiers modèles de type .tpl (template) utilisés
dans la commande d'impression de carte.

• Ajoutez un nouveau thème ponctuel/ligne/polygone ici ou faites un clic-droit dans la
zone de travail et choisissez "nouveau thème" à partir de la fenêtre pop-up. Lors de la
création de thèmes ponctuels l'ajout des attributs de coordonnées X et Y est possible.

• Exportez la vue vers une image sauvegardera la vue entière de votre zone de travail
affichée en fichier image géoréférencé de format JPEG, TIFF, BMP ou PNG (génère le
fichier de géolocalisation associé). Pour sauver juste une partie d'une vue en fichier
image, utilisez l'outil export d'image de la barre d'outils.

• Exportez la légende vers une image sauvegardera la liste des thèmes (et tous les
symboles de la légende dont vous avez permis l'affichage via la boîte de dialogue de
propriétés) dans un fichier image. Utilisez cette image de la légende pour expliciter les
cartes fGIS imprimées en tant que document ou illustration.

Menu Thème :

• Accédez aux "propriétés du thème" par ce menu ou par double-clic sur le nom
d'un thème dans la liste des thèmes.



Le bouton "Wizard" lance l'assistant pour la représentation des couches, issu du
moteur de rendu inclus dans la dernière version du kit de développement
TatukGIS DK. Les entités vectorielles peuvent être automatiquement
représentées par différentes combinaison de couleurs et largeurs de traits en
fonction des valeurs distinctes contenues dans l'attribut de votre choix ou à l'aide
de dégradés de couleur.
Des commentaires peuvent être ajoutés dans la boîte de dialogue " propriétés du
thème > onglet " Layer " > section d'information " info "et être sauvegardés avec
le projet ou dans le fichier " .ini " (enregistrer les propriétés du thème dans un
fichier .ini).

• Cadrez sur le thème adaptera l'échelle de représentation de la zone de travail
pour permettre l'affichage de toutes les entités du thème.

• Zoom sur la sélection adaptera l'échelle de représentation de la zone de travail
pour permettre l'affichage de toutes les entités sélectionnées du thème.

• Déselectionner enlève les marques de sélection de votre carte.
• Sélection de la dernière entité sélectionnera la dernière entité ajoutée à un

thème shapefile. Ceci peut être utile pour sélectionner les entités nouvellement
ajoutées qui se superposent à d'autres, typiquement les nouvelles entités qu'on
veut découper ou soustraire à d'autres polygones.
La commande "Sélection de la dernière entité" a été ajoutée au menu popup de
la vue.

• Monter/Descendre le thème : Changez l'ordre des thèmes ici ou en déplaçant
le nom d'un thème vers le haut ou vers le bas dans la liste des thèmes.

• Cacher dans la légende : Utile pour libérer de l'espace dans la légende
(particulièrement si vous avez chargé un catalogue d'image avec beaucoup de
tuiles). La commande 'Indiquer tous les thèmes' est situé dans le menu
'Carte' .

• Employez 'Changer le nom d'un thème' pour donner aux thèmes un nom
descriptif clair (plutôt qu'un nom de fichier informatique avec son emplacement)
dans la liste des thèmes servant pour la légende. Remarque : Vous pouvez
également changer un nom d'affichage par clic-droit dans la légende (quand fGIS
n'est pas en mode d'édition), qui appellera ce menu :



• Enregistrer les Propriétés du Thème dans un fichier .ini est utilisé pour
sauvegarder les paramètres d'affichage du thème. Un petit fichier reprenant le
même nom de fichier que celui du thème, mais postfixé ".ini", est ajouté dans le
répertoire où réside le fichier shapefile. Si vous chargez ultérieurement ce thème
dans un projet différent, il sera affiché directement avec les caractéristiques
définies dans le fichier ".ini" (si vous modifiez les propriétés d'un thème dans un
projet particulier, les propriétés du projet seront lues en priorités sur celles du
fichier ".ini"). Si vous incluez le fichier ".ini" dans les données que vous envoyez à
quelqu'un, celui-ci pourra charger directement le thème avec les propriétés
d'affichage que vous avez définies.

• 
Ouvrir la Table du fichier Shapefile est un afficheur/éditeur qui montre les
attributs de toutes les entités d'un thème Shapefile. Utilisez-le pour rechercher
une entité particulière en fonction d'une valeur d'attribut. L'outil est également
utile pour mettre à jour ou changer des valeurs d'attribut.
Notez que la fenêtre peut être rendue pleine page pour une édition plus facile des
grandes tables.

• pour modifier une valeur d'un champ, cochez 'Edition', déplacez vous sur
l'attribut que vous voulez changer, et utilisez la touche 'Suppression
arrière' pour supprimer l'ancienne valeur avant de saisir la nouvelle. Les
modifications sont immédiatement sauvegardées dans le fichier.

• Puisque cet outil peut être employé pour éditer des données
tabulaires, il ne peut pas être utilisé tandis qu'un shapefile est
édité par 'Mise à Jour' dans la vue (Menu Edition/Mise à jour).

• La commande 'Table> Recalcul des Champs mesurés'



actualise les champs Acres, Pieds, Miles, Hectares, Metres, X, et
Y des enregistrements sélectionnés si ces champs existent

• Le bouton 'Chercher' recherchera, dans l'attribut sélectionné,
la valeur saisie et déplacera l'indicateur de rangée à la première
ligne correspondante. Si les lignes ne sont pas triées, la
recherche ne sera pas sensible à la casse (majuscule ou
minuscule), et pourra être partielle (ainsi 'A', permettra de
trouver 'arbre'). Si les lignes sont triées, la recherche sera
sensible à la casse (ainsi 'arbre' permettra de trouver 'arbre',
mais pas 'Arbre').

• Le bouton 'Ecrire' écrira pour toutes les lignes sélectionnées, le
contenu saisi comme valeur pour l'attribut sélectionné (si la
coche 'Edition' est activée).

• La case à cocher 'filtre' filtrera la table sur la valeur saisie dans
le champ d'entrée pour la zone choisie.

• Vous ne pouvez sélectionner qu'un seul attribut à la fois (en
cliquant sur le nom de la colonne), mais vous pouvez
sélectionner plusieurs lignes simultanément en maintenant la
touche 'Ctrl' enfoncée.

D'autres informations sont présentes en cliquant sur le bouton d'aide.

Le nombre d'enregistrements choisis et le nombre total des enregistrements
de la table sont affichés. Mais ces nombres sont incorrects si les
enregistrements sont triés, aussi ils ne sont pas rendus visibles jusqu'à ce que
le tri soit annulé.

Pour ajouter un nouveau champ au modèle de données du thème, vous devez
utiliser la commande 'Ajouter un Champ' et être dans le mode 'Mise à Jour'
du menu édition.

La commande 'Tout' permet de sélectionner toutes les lignes de la table.
La commande 'Désélectionner' permet de désélectionner les lignes
sélectionnées.
La commande 'Inverser' permet d'inverser la sélection dans la table.

La commande 'Faire Flasher' permet de faire clignoter les entités associées
aux lignes sélectionnées.



Les commandes 'conformer la sélection à la table' ou 'conformer la
sélection à la carte' permettent de gérer la mise en cohérence de la
sélection des lignes dans la table avec la sélection des entités graphiques
dans la carte.
La commande 'conformer la sélection à la table' sélectionnera sur la carte
toutes les entités dont les enregistrements sont sélectionnées dans la table.
La commande 'conformer la sélection à la carte' sélectionnera dans la table
tous les enregistrements dont les représentations sont sélectionnées dans la
carte.

La commande 'Copier la sélection' copiera les enregistrements sélectionnés
dans le presse-papier dans un format séparé par des tabulations. Ce format
peut être collé dans le logiciel Excel.

Les commandes 'Tri Croissant' et 'Tri Décroissant' permettent de trier
dans un ordre croissant ou décroissant les lignes en fonction de la valeur de
l'attribut (colonne) sélectionné.
La commande 'Annuler le Tri' supprime les tris effectués. (Quand les lignes
sont triées, un verrouillage temporaire est réalisé sur la table attributaire et
un fichier '.mdx' est créé. Ce fichier '.mdx' peut être supprimé à la fermeture
de l'outil).

La commande 'Analyse statistique' fournit l'analyse statistique de l'attribut
(numérique) sélectionné en générant la somme, la moyenne, le minimum, le
maximum et l'intervalle des valeurs pour les lignes sélectionnées.

Vous pouvez également ajouter un champ, changer la valeur d'un champ
directement dans la sélection :

1 . Sélectionner un thème

2. Démarrer le mode mise à jour : clic droit sur la vue puis 'Mise à
jour' ou Menu Edition/Mise à jour

3. cliquer sur l'outil champ de la barre d'outil

4. cliquer (clic gauche) sur la vue avec l'outil champ pour effectuer
votre sélection. La table attributaire s'ouvre.



5. Un clic droit dans la colonne UID permet d'ouvrir le menu
ajouter/modifier/supprimer un champ

6. Pour changer la valeur du champ il suffit de se positionner sur la
valeur à modifier, l'effacer et écrire la nouvelle valeur

7. Il faut enregistrer la mise à jour pour qu'elle soit prise en compte.

• La fonction 'Image Valeurs de transparence' n'est utilisable qu'avec les
fichiers images, elle lance une boîte de dialogue qui permet aux utilisateurs de
rendre les cadres de DOPs et les arrières-plans de DRGs transparent. Les
paramètres par défaut devraient fonctionner pour la plupart des utilisateurs. Ceci
pourrait être utile pour modifier la représentation d'autres images.

• La fonction 'Exporter un thème' peut exporter qu'une partie d'un fichier
vecteur. La partie sauvegardée peut être choisie grâce à une sélection réalisée au
préalable.
La commande d'exportation utilise seulement la couche active, choisie dans la
légende.
La case à cocher 'que la Sélection' de la boîte de dialogue 'Exporter un Thème'
doit être utilisée après avoir fait une sélection (choisissez les entités à
sélectionner avec l'Outil de Sélection, ou par une requête grâce à l'action
'Rechercher' du menu 'Carte') pour exporter uniquement certains objets
spécifiques.



Menu Edition:

• Si vous y accédez à partir de la barre de menu, le menu d'édition a l'aspect
indiqué à gauche. Vous pouvez également accéder au menu d'édition par clic-
droit dans la zone de travail. Auquel cas, un menu d'édition comme ci-dessous
apparaitra sous votre curseur :

• En mode 'Mise à jour', la barre d'état devient rouge.
• Début/fin de Mise à jour :

• Si vous digitalisez un objet complexe, mais que le point saute loin de la
position principale, annulez la dernière action pour éliminer l'erreur et puis
maintenez la touche MAJ. enfoncée avant de cliquer la position
correcte. Les cours d'instruction sur la digitalisation sont disponibles ci-
dessous. Essayez toujours de digitaliser des polygones dans le sens
contraire des aiguilles d'une montre, afin de donner aux sommets
du polygone un enroulement dans le sens des aiguilles d'une
montre. C'est essentiel pour que l'outil 'Scinder' de division et
d'autres fonctions d'édition de polygone fonctionnent
correctement. Employez 'Fonction sur les polygones>Fixez le sens
d'enroulement du polygone' si nécessaire pour donner aux sommets un
enroulement dans le sens des aiguilles d'une montre.

• Vous pouvez modifier la table d'attributs des données d'une entité quand



vous êtes en mode d'édition. Cliquez sur l'entité avec l'outil 'Champs' 
pour ouvrir sa table de données. La surface (acres) et le périmètre (pieds)
sont automatiquement complétés (utile pour des peuplements de forêt).
D'autres champs (types de bois de construction par exemple) que vous
ajoutez sont complétés manuellement en cliquant deux fois (lentement)
dans la colonne droite. Cliquez la colonne gauche une fois pour ajouter,
modifier ou supprimer un nom de champ.

• Vous devez cliquer sur "Fin de mise à jour" et sauvegarder votre
travail avant que vous puissiez changer de thème ou faire des
changements de propriétés dans la liste/légende des thèmes.

• La commande 'Fermer l'entité' présente dans le menu d'édition et dans le menu
popup de la vue permet de fermer la forme lors de sa construction par points (le
dernier point est égal au premier) et permet l'utilisation de l'outil 'Champs'.

• Les fonctions additionnelles sur les polygones sont :
1. Soustraire le Polygone : Les géometries de tous les polygones qui
recouvrent le polygone choisi seront soustraits du polygone choisi.  Ceci
permet de juxtaposer des polygones aux polygones existants ou de remplir
des trous entre les polygones.
2. Fixer le sens d'enroulement du polygone: Les polygones aux points
définis dans le sens des aiguilles d'une montre fonctionnent mieux avec les
outils sur les polygones : Soustraire, Découper.... Employez 'Fixer le sens
d'enroulement du polygone' pour donner aux sommets l'ordre correct.
4. Découper avec le Polygone: La géométrie du polygone choisi sera
soustraite de la géométrie de tous les polygones qu'elle recouvre. De cette
manière vous pouvez découper à l'emporte-pièce avec de nouveaux
polygones.
5. Supprimer le morcellement: Différentes parties de polygones à parties
multiples peuvent être supprimées.
Les commandes " Soustraire les polygones " et " Découper avec le polygone "
fonctionnent seulement avec une entité qui est choisie avec l'outil de sélection (ceci
permet d'annuler les polygones multiples).
• La commande 'Fusion des entités sélectionnées' : toutes les entités choisies

avec l'outil de sélection  seront fusionnées dans une nouvelle entité. Cette
commande fonctionne pour des lignes et des polygones.

• Sélectionner la dernière entité : cette commande peut être utile pour
sélectionner le dernier thème créé afin de lui appliquer les fonctions
additionnelles sur les polygones "soustraire le Polygone", "découper avec le
Polygone", "supprimer le morcellement".

• Fixer La Tolérance de Capture : La distance par défaut du système est 15. Les
valeurs plus grandes que 35 ne sont pas recommandées. (choisissez le thème
pour se caler par capture des points existants dans la barre d'outil de fGIS.)



Menu Utilitaires:

• "Charger une Bibliothèque de Thèmes" simplifie le chargement des thèmes
SIG. Si vous avez une grande collection  de données de SIG, les conventions
d'appellation ont souvent comme conséquence des noms codés de fichiers. En
outre, les thèmes sont souvent stockés dans beaucoup de dossiers (qui ont
également des noms codifiés). Vous pouvez éliminer la difficulté d'avoir à se
rappeler où est quoi en créant une table au format DBF comportant un alias
simple pour chaque nom et chemin de chaque fichier. Une fois que vous avez
créé une telle table, chargez simplement cette bibliothèque et cliquez les thèmes
voulus dans cette table, fGIS ajoutera automatiquement le thème à la liste des
thèmes de votre carte.

Voici un exemple de fichier DBF contenant des chemins et des noms de
fichiers en langage compréhensible :

Vous pouvez utiliser 'Ajouter une variable Env' pour définir un chemin à
chaque fichier, ou vous pouvez employer l'éditeur Notepad pour faire la même
chose en créant un fichier appelé "env.txt" dans votre dossier contenant le
programme fGIS. Voici un exemple de fichier texte d'environnement pour les
deux premiers fichiers montrés ci-dessus :



Dans cet exemple, les fichiers shapefiles peuvent être trouvés sur le disque
C:\ de l'utilisateur comme indiqué. Une fois que le fichier bibliothèque est
défini, cliquez juste une fois sur le thème que vous voulez, et fGIS le
chargera.

NOTE AUX FORESTIERS DU WISCONSIN : L'archives ZIP de distribution de fGIS inclue
un fichier d'"env.txt" et un fichier d'"layrdata.dbf", qui sont basés sur la disposition du
magasin de données de dvgislib du Wisconsin DNR. Le dossier d'env.txt suppose que vos
données de SIG du Wisconsin DNR sont sur votre ordinateur local suivant le répertoire
suivant : "C:\GIS_DATA\dvgislib\wi_tile \". Si vos données sont dans un répertoire
différent (tel qu'une tuile régionale), vous pouvez éditer le dossier d'env.txt (utilisez
rechercher/ remplacer dans WORD) pour indiquer le chemin vers le répertoire que vous
utilisez. N'employez pas d'espaces ou le caractère tiret (-) dans des noms de fichier ou de
dossier ! Si vous ouvrez layrdata.dbf avec la commande 'Charger une Bibliothèque de
Thèmes' et que le fichier shapefile soit présent, alors fGIS chargera ce thème quand vous
cliquerez sa rangée dans la table de données.

Gardez à l'esprit que les tuiles régionales des bibliothèques du Wisconsin ne
contiennent pas toutes les couches présentes dans la bibliothèque du Wisconsin. Si
une couche n'est pas présente sur votre installation locale, vous obtiendrez le
message suivant :

• L'Utilitaire de Changement de Projection convertit des fichiers shapefiles
entre les systèmes géographiques (lat/lon) d'UTM NAD83 et de WTM NAD83.
Dans l'exemple suivant, un fichier shapefile géographique de recensement est
converti en UTM15 :

Penser à organiser vos fichiers shapefiles en dossiers avec des noms logiques.
Si un fichier source a un nom codé, vous pourriez vouloir le changer en nom



compréhensible comme montré dans l'exemple ci-dessus.

Les nombres de zones UTM du Wisconsin sont ici. Des zones d'UTM 10-19
sont incluses dans l'utilitaire de projection de fichiers Shapefile de fGIS.

• L'Utilitaire de Conversion d'Unités interprète des mesures d'unité, traduisant
une valeur n'importe quelle autre unité. Sélectionner l' Utilitaire de Conversion
d'Unités lance le programme de convertion de Josh Madison (plus d'informations
sur le programme de convertion peuvent être trouvées dans le fichier
convert_readme.txt dans le dossier d'installation de fGIS). Annulez le mode
d'édition avant d'employer le convertisseur.

Typiquement, vous emploierez le convertisseur (1.) en copiant une valeur
d'une table d'attribut (cliquez sur une cellule pour la rendre active, et copier
automatiquement sa valeur). Dans le convertisseur, (2.) coller la valeur à
traduire dans le champ 'Input' et lisez la valeur convertie dans le champ
'Output'. Employez les onglets dans le convertisseur pour choisir les unités
d'entrée et de sortie. Les deux étapes sont montrées ci-dessous en entrant
une valeur de surface en mètre carré d'une table d'attribut de section du
Wisconsin DNR PLSS, pour la changer en acres.



• Joindre une Table 'dBase' à un fichier 'Shapefile' permet de joindre une
table de forme dBase à une table d'attributs des shapefile en se basant sur un
champ commun de chacun. Les noms de champ commun n'ont pas besoin d'être
identiques. Les champs communs devraient, cependant, contenir le même type
de données.
La jointure est exécutée uniquement dans un mode 'un-vers-un'. Dans le cas
d'une relation multiple, seul le premier enregistrement de la table d'entrée sera
associé au shapefile en sortie.
Le processus de jointure peut prendre plusieurs minutes pour les shapefiles
importants et les tables volumineuses.
Note : Les tables d'Access et Excel de Microsoft® peuvent être facilement
exportées comme fichiers au format dBase (.dbf) pour utilisation dans fGIS.

 
• Joindre une Table 'Access' à un fichier 'Shapefile' permet de joindre une

table Access à un thème shapefile. L'action de jointure avec la base de données
est ici "directe" . Les champs joints sont rendus visibles des les boîtes de



dialogues  "Propriétés du Thème", "Rechercher" et via l'outil d'information 
outil champs. Le champ de jointure doit être un numérique entier.

La fonction "Trier le Fichier" est nécessaire au bon fonctionnement de la jointure.
Il faut produire un fichier shapefile trié sur le champ de jointure, puis le recharger
dans fGIS pour effectuer sur lui la jointure : 

a. Cette fonction triera le fichier shapefile sélectionné suivant les valeurs du
champ choisi et produira un nouveau shapefile trié. Ce  nouveau fichier
shapefile doit être ajouté dans FGIS (ajouter un thème) afin de pouvoir
l'utiliser pour la jointure avec la  table Access associée (b).
b. Les enregistrements de la table Access sont aussi triés par le champ de
jointure avant de procéder à l’appariement. La jointure fonctionne mieux et
plus rapidement s'il y a un rapport unaire (1-1) entre les enregistrements de
la table Access et les entités du fichier shapefile , ET si les enregistrements et
entités sont triés par le même champ.

• Lat/Lon en WTM ... ce dispositif est spécifique aux utilisateurs de la projection
WTM de l'état du Wisconsin (il est adapté à la lutte contre le feu du Wisconsin
DNR). Il permet de zoomer sur un point en WTM correspondant au point saisie en
coordonnées Lat/Lon. Il affichera également une description légale si un thème
surfacique DTRS est chargé dans la vue.
La commande " WTM en Lat/Lon " a été ajoutée au menu popup de la vue. Il
lance une boîte de dialogue avec les coordonnées en Lat/Lon du point
correspondant au clic droit de l'utilisateur. Les unités de projection du thème
doivent être en mètres et le système doit être le Wisconsin Mercator transversal
pour que ceci fonctionne correctement. Si vous vouler ajouter les coordonnées
lat/lon comme annotation sur la carte, créez une couche de point et collez (Ctrl-
V) le texte de lat/lon dans la table de l'attribut du point.
Le positionnement " Lat./Lon. en WTM " place un point rouge sur la vue.

• Importer une table XY en shapefile Cette commande crée un thème ponctuel
à partir d'une table textuelle de coordonnées XY en degrés décimaux délimitées



par des virgules. La table textuelle à importer doit contenir les quatre champs
suivant dans cet ordre: ID, X (longitude), Y (latitude), Text. Les noms de champs
peuvent être personnalisés par l'utilisateur et seuls les champs d'IDentification et
de Texte apparaîtront dans la table d'attribut. Seule la séparation des valeurs par
virgule peut être employée. Des valeurs de textes avec des espaces doivent être
encadrées de doubles guillemets. Voir le fichier exemple
Cliquer sur "Importer" pour créer le shapefile qui peut être chargé comme un
thème dans un projet fGIS.

Astuce : Si vous utilisez un programme comme Waypoint+ pour récupérer les coordonnées
à partir d'un receveur GPS Garmin et les sauvegarder au format texte délimité par des
virgules, cet utilitaire de fGIS vous permet de créer un fichier shapefile de votre itinéraire
GPS. Vous pouvez avoir besoin de l'utilitaire de changement de projection pour afficher
correctement ce nouveau thème avec vos autres thèmes déjà projetés.

• Utilitaire Catalogue d'images ... Les catalogues d'image sont des tables dBase
qui stockent une liste des images qui sont toutes chargées dans la vue
immédiatement. La boîte de dialogue 'Catalogue d'images' permet d'ouvrir un
fichier référençant l'ensemble de ces images. Les noms de fichier d'image sont
typiquement stockés dans un champ appelé " Image ". Le chemin complet et le
nom de fichier pour l'image doivent être inclus. Les options "Cache tout"/"Indique
tout" permettent de cacher ou montrer dans la légende l'ensemble des images
chargées et les options "Masque tout"/"Affiche tout" permettent de masquer ou
montrer l'ensemble des images dans la vue. Pour utiliser ces quatre option il faut
d'abord sélectionner le format des images.

• Visualisation 3D
"Exporter la vue en 3-D..." Le DTM en entrée peut être n'importe quelle
image numérique de modèle de terrain chargée dans la vue. Le DTM en Sortie
est employé comme modèle de terrain dans la visionneuse 3-D. L'Image en
sortie est employée comme image de recouvrement dans la visionneuse 3-D.
Conseils d'utilisation: Changez le type de fichier du modèle de terrain en
image tiff (*.tif). Décochez Monochrome pour des couleurs multiples. Voyez
l'aide en ligne de fGIS pour plus d'information (en anglais).
"Lancer la visionneuse 3-D".

• Hyperlien change la fonction de l'outil de sélection de sorte que lorsque l'entité
est sélectionnée, le fichier indiqué dans le champ d'hyperlien soit montré via le
programme par défaut pour ce fichier (images, documents textes, pages web,
etc.).

Menu Aide:

• Par F1 ou 'Aide de fGIS' vous obtiendrez l'index d'aide (l'aide de fGIS dans le
programme est identique à la version sur l'Internet.)

• 'A propos de fGIS' fournira l'information de base des copyrights de fGIS. Le
dossier "license.txt" dans le dossier d'installation du programme fGIS fournit des
détails complémentaires.



  

Outils

• Enregistrer le Projet 
Sauvegarde le projet et la vue courante. Pour sauvegarder le projet avec un nom
différent (laissant intact l'original), employez "Enregistrer le Projet Sous" du menu
Carte. La visibilité d'une couche peut être sauvegardée dans le fichier projet (si vous
sauvegardez un projet avec quelques couches positionnées "Visible/Invisible", le
projet se rouvrira avec la même configuration).

• Imprimer la Carte 
Après avoir cliqué Imprimer/OK, fGIS vous proposera de définir un titre, un sous-
titre et un bas de page pour votre carte. Vous pouvez également indiquer l'échelle à
laquelle imprimer et choisir les polices à utiliser pour les titres et bas de page (si
vous souhaitez imprimer à une échelle de huit pouces par mille, indiquez une échelle
de 1:7920). Un aperçu avant impression est présent.

fGIS offre plusieurs options d'impression supplémentaires :
• Envoyer la Carte vers Word (disponible par le sous-menu :

"Carte>Imprimer") enverra une image de la vue à la résolution et à l'échelle
indiquées par l'utilisateur vers Microsoft Word® . L'utilisateur peut au choix
ajouter la carte à un document existant (naviguer jusqu'au document) ou
créer un nouveau document. Un fichier document d'en-tête de carte du
Wisconsin DNR MFL est inclus dans le dossier de fGIS si nécessaire. L'outil
d'image "Rogner" dans Word crée un masque autour de l'image sans changer
l'échelle ou distordre l'image. L'outil "Rogner" est disponible sur la barre
d'outils image de Word (utiliser : "Affichage>Barre d'Outils" dans Word pour
lancer cette barre d'Outils). Appliquez l'outil "Rogner" aux poignées du milieu
des bords d'image pour obtenir les meilleurs résultats. Vous pourriez devoir
déplacer l'image dans les deux sens pour accéder aux bords.) En outre, fGIS
ajoute l'échelle de la carte (par exemple 1:7920) comme texte dans Word
pour la référence de l'utilisateur. Envoyer la carte vers Word a été testé sur
Word 97, 2002 et 2003 avec des résultats satisfaisants.



• Une autre option par l'outil Export d'Image enverra la carte au module
Diagram Designer pour des illustrations ou mises en pages techniques.
Vous pouvez ajouter des en-têtes, des légendes, des annotations et des
symboles non-spatiaux à partir des palettes de forme dans le module de
concepteur de diagramme. 

Note: À quelques échelles, les étiquettes d'objet placées avec l'option de position "Follow"
pourraient ne pas s'imprimer correctement. C'est une limitation du pilote logiciel
d'impression inhérente au composant logiciel utilisé pour développer fGIS. Si cela se
produit, changez les propriétés d'étiquette de ces objets pour les mettre en orientation
horizontale.

• Thème 
permet d'ajouter/supprimer un thème du projet. Vous pouvez sélectionner plusieurs
fichiers à la fois dans la boîte de dialogue en maintenant la touche 'shift' ou 'Ctrl'
enfoncée. Ces fonctions ne sont pas accessibles en mode Edition.

• Vue précédente 
repositionne la vue sur la cadrage précédent. Seules les 10 vues précédentes sont
disponibles. Les vues précédentes sont créées automatiquement lors de l'usage des
outils zooms, déplacement et recentrage (pas lors de l'utilisation des ascenseurs).

• Zoom et Position 
fGIS fournit un certain nombre d'outils pour changer la vue.

• Le premier, avec un globe, cadrera totalement tous les thèmes chargés. (si
vous voulez zoomer sur une couche particulière, utilisez "Cadrer sur le
Thème" de la barre de menu).

• Les deux outils suivants (- et +) zooment en arrière ou en avant de manière
incrémentale.

• La loupe ouverte est un zoom libre élastique. Dessinez un rectangle vers le
bas et la droite pour zoomer en avant. Dessinez un rectangle vers le haut et
la gauche pour dézoomer.

• L'outil de déplacement (main) est utilisé pour déplacer la vue dans une
nouvelle position avec la souris.

• Le dernier outil recentrera la vue sur n'importe quel point que vous cliquez
(clic-gauche).

• Champs 
L'outil Champs montrera l'information des attributs (reprenant le modèle de
données) de n'importe quel objet que vous cliquez dans la vue. L'objet clignotera
d'abord en rouge et jaune, puis une table d'attributs s'ouvrira. Cet outil travaille
seulement sur la couche active choisie dans la légende.

Note: Si vous utilisez l'outil Champs, mais ne parvenez pas à "cliquer" l'objet que vous
voulez, déplacez le thème cible contenant l'objet vers une position plus élevée dans la liste
des thèmes . Chaque couche de thème correspond en gros à un calque. Vous ne pouvez pas
atteindre un objet dans un calque inférieur si un objet dans un calque plus haut le protège.

Si vous êtes en mode d'édition (clic-droit dans la vue et cliquez "Mise à jour"), vous
pouvez utiliser l'outil Champs pour changer les valeurs de données liées à un objet.
Après avoir cliqué sur un objet, une table avec deux colonnes semblable à l'exemple
suivant (avec un modèle de données propre à l'objet) s'ouvrira :



Cliquez dans la colonne gauche pour changer une étiquette de champ ou
ajouter/supprimer un champ. Cliquez dans la colonne de droite pour changer une
valeur d'attribut. Cliquez OK quand vous avez fini pour sauvegarder vos
changements.

•  Sélection L'outil de sélection permet de choisir des entités de la couche active
dans la légende. Les entités choisies sont mises en valeur en rouge. Plusieurs entités
peuvent être choisies en maintenant la touche CTRL tout en utilisant l'outil. Les
entités ainsi sélectionnées peuvent être fusionnées avec la commande 'Fusion des
entités sélectionnées'. Plusieurs entités sélectionnées avec l'outil de sélection
peuvent être effacées simultanément. Seules les entités choisies avec l'outil de
sélection seront effacées avec la commande "Supprimer".

Note: cet outil de sélection a des fonctions différentes de l'outil 'Editer les
points/sélectionner': une entité doit être choisie avec l'outil 'Editer les points'(en cliquant
près du centre de l'entité) afin de manipuler ses points ou sommets, vous ne pouvez choisir
qu'une seule entité à l'aide de l'outil 'Editer les points', et il est seulement disponible dans le
mode d'édition.

•  Mesure 
Cliquez des points pour former une ligne ou une surface. Double-cliquez pour obtenir
les mesures. Les mesures sont rapportées en acres, pieds, chaînes (1 chaîne = 66
pieds) et miles (mile statutaire anglosaxon, soit "1609,344" mètres), et aussi en
hectares et mètres. Ce résultat est automatiquement copié dans le presse-papier.

• Export d'Image 
Tirez un rectangle englobant pour exporter une image geo-référencée de n'importe
quelle partie de la vue d'écran. L'outil export d'image peut être utilisé, par exemple,
pour créer une image de juste une section.
Après avoir tiré un rectangle englobant, la boîte de dialogue suivante, demandant la
résolution, s'ouvrira.



La résolution par défaut de 1 sauvegardera l'image à la résolution d'écran (ce qui
pourrait générer une image médiocre à l'impression). L'augmentation de la
résolution aura comme conséquence un fichier image plus volumineux avec une
impression de meilleure qualité. Ce choix dépend des résultats que vous cherchez (la
résolution de 2 est habituellement optimale pour des cartes du Wisconsin MFL, si
vous cadrez pour remplir la vue de la section de PLSS) .
Des images peuvent être sauvegardées dans des formats TIF, PNG, BMP et JPG
(avec le fichier de géolocalisation associé). Le format PNG est particulièrement utile
pour les cartes qui n'incluent pas des images raster comme les photos aériennes, car
il génère un volume de fichier relativement petit.

Quand vous utilisez l'outil export d'image, une option vous permettra d'ouvrir l'image
dans le créateur de diagramme, dans un module de mise en page. Vous pouvez en
apprendre plus au sujet du module créateur de diagramme ici.

[note : Si une image ne s'ouvre pas dans le créateur de diagramme au premier
essai, répétez l'exportation d'image une deuxième fois en utilisant le même nom de
fichier que la première fois. L'image s'ouvrira dans le concepteur de diagramme sur
le deuxième essai. C'est un bogue connu dans fGIS, qui sera corrigé. En outre, les
images exportées doivent être sauvegardées dans un format png, bmp ou jpg si elles
doivent être utilisées dans le module créateur de diagramme.]

• Scinder l'entité 
L'outil Scinder l'entité permet de diviser un polygone (ou un thème linéaire) en
plus petites unités en traçant sur lui une ligne. La séparation de l'entité met à jour
l'aire et le périmètre de chaque sous-unité quand un objet polygone est divisé.

Découper un polygone avec une ligne
(Double-clic pour terminer la procédure.)

Une des méthodes les plus faciles pour digitaliser les polygones (par exemple des
types de couverture de forêt) est de définir d'abord une emprise globale, puis
d'utiliser l'outil scinder l'entité pour subdiviser le tout en ses parties.
De temps en temps, vous pourriez rencontrer un polygone qui affiche un
avertissement indiquant que l'entité ne peut pas être séparée quand vous essayez
de la subdiviser. Cela est provoqué par une certaine irrégularité dans la structure
des données de l'objet. Si cela se produit, utilisez l'outil d'édition des points pour
ajuster légèrement l'objet, et puis essayez l'outil scinder l'entité à nouveau.



Avertissement! Une précaution à garder à l'esprit avec l'outil scinder l'entité: N'essayez
pas de suivre la frontière d'une forme. Puisque l'outil scinder l'entité ne se cale pas par
capture sur d'autres objets, l'essai de suivre une autre frontière aura comme conséquence
des "orphelins" (des rubans de polygone que vous devrez supprimer et nettoyer plus tard).
Optimisez votre mode opératoire afin de diviser proprement les polygones, en utilisant plus
d'une séparation si nécessaire.

• Editer les Points/Sélectionner 
Choisissez le thème contenant les objets que vous voulez éditer, puis faites un clic-
droit dans la vue et choisissez "Mise à jour". Cliquez l'outil Editer les Points, et puis
cliquez (clic-gauche) sur l'objet que vous voulez sélectionner. Cliquez près du centre
de l'objet pour éviter de changer un vertice sur le premier clic. Déplacez les noeuds
ou insérez les sommets avec l'outil d'édition des points.
Les fonctions additionnelles de polygone qui peuvent être employées avec l'outil
'Editer les Points/Sélectionner' sont énumérées ci-dessous.

Remarque : Il est souvent plus facile de digitaliser une forme complexe en l'enfermant
d'abord dans un polygone simple. Puis, utilisez l'outil Editer les Points/Sélectionner pour
amener la forme à se conformer à l'objet devant être digitalisé.

• Créer une Entité 
Quand vous êtes en mode d'édition, cliquez l'outil Créer une Entité pour insérer un
autre objet dans le thème actif. Pour créer un nouveau thème, faites un clic-droit
dans la vue et choisissez la catégorie appropriée de thème à partir du menu popup :

Il vous sera proposé optionnellement d'ajouter automatiquement à la table des
attributs de surface et longueur (pieds, acres, mètres et hectares).

Notez que le menu d'édition inclut un sous-menu de fonctions sur
les polygone :

Ces outils permettent de digitaliser des formes complexes dans fGIS
sans produire des objets "orphelins" ou des vides entre les polygones.
Regardez les exemples suivants (déroulement des actions de la
gauche vers la droite) :



Découper avec le polygone :

Soustraire les polygones :

La commande "Fixer le Sens d'Enroulement du Polygone" est
utilisée pour ordonner les sommets d'un polygone dans le sens des
aiguilles d'une montre. Vous devriez généralement dessiner les
polygones dans un sens anti-horaire (ce qui permet aux sommets
d'être numérotés dans le sens des aiguilles d'une montre). Quand des
sommets sont numérotés dans le sens des aiguilles d'une montre, le
polygone peut être scindé ou manipulé de beaucoup de manières. Si
vous l'oubliez cependant, utilisez l'outil "Fixer le Sens d'Enroulement
du Polygone".

"Supprimer le morcellement" enlève le morceau en cours d'édition
du polygone sélectionné.

L'outil "Découper avec le polygone" est employé pour faire des îles,
des lacs et d'autres trous dans des polygones.

• Saisie de Points par Angle et Distance 
Utilisez cet outil pour spécifier la direction et la distance du prochain sommet dans



un objet point, ligne ou polygone. Indiquez la direction en degrés ou degré-minute-
secondes d'azimut, puis saisissez la distance au point en pieds par exemple. Cet outil
de fGIS permet de tracer la plupart des formes contractuelles en respectant une
forme précise (que vous pourriez transférer à une unité GPS avec l'outil de DNR
Garmin).

 

NOTE: les surfaces de polygone dans fGIS sont estimées sur le nombre de pixel d'affichage
de l'objet. En conséquence, l'échelle d'affichage peut avoir un effet sur la surface calculée,
car une représentation à une échelle réduite générera moins de pixel pour un objet qu'à un
zoom à grande échelle. Par exemple, un polygone 5.280 de pieds carrés pourrait être
mesuré à exactement 640,0 acres quand la vue est au 1:15,840. Quand l'affichage est à
une plus petite échelle de 1:100,000, un polygone digitalisé à 5.280 pieds par côté pourrait
être estimé dans fGIS à 643 acres par exemple. L'erreur potentielle est petite, mais les
utilisateurs doivent être avertis que les mesures de surface sont faites par estimation des
pixels plutôt que par des calculs trigonométriques exacts.

• Annuler/Rétablir 
Cliquez Annuler pour enlever un sommet incorrect ou Rétablir pour reconstituer un
point supprimé en éditant une forme. Les outils Annuler/Rétablir servent pour
l'édition des points et ne fonctionnent pas pour d'autre fonction.

• Capture
En digitalisant une forme, vous pouvez permettre le calage par capture sur des
objets de n'importe quelle couche de vecteur en choisissant la couche appropriée
dans la liste déroulante. Les noms de thèmes de vecteur utilisés dans la légende
seront montrés comme dans cet exemple:

La couche d'accrochage par capture peut être changée à tout moment. Par exemple,
vous pourriez commencer par vous caler sur une couche de route, puis vous caler
sur une rivière quand l'objet que vous digitalisez s'approche des entités de la couche
hydraulique.



  

Propriétés du Thème
Le menu Propriétés du Thème peut être également lancé par double-clic sur un nom de
thème présent dans la liste des thèmes (note : vous devez sortir du mode d'édition avant
que vous puissiez accéder à cette boîte de dialogue).
fGIS et la visionneuse gratuite de TatukGIS (tous deux construits avec l'environnement de
développement TatukGIS DK) partagent les même caractéristiques et possibilités de
définition de propriétés. Nous vous conseillons de lire le pdf d'aide de la visionneuse de
TatukGIS pour obtenir des compléments d'informations et des exemples supplémentaires
illustrant les propriétés.

• L'étiquettage des thèmes vectoriels offre des possibilités étendues pour ajuster
l'affichage des informations portés par les vecteurs. Ci-dessous sont présentés les
principales fonctionnalités de chaque onglet sur les propriétés:

La première option dont vous pouvez
avoir besoin dans l'onglet "Layer"
(couche) est la transparence. Si vous
ajustez les propriétés d'un objet
surfacique, réduisez la valeur dans
"Transparency" (Transparence) si
vous voulez voir au travers de l'objet
les couches sous-jacentes. Vous
pouvez également définir le champ
"Pattern" de l'onglet "Area" (ci-
dessous) à "TRANSPARENT" si vous
voulez que seul le contour de l'objet
s'affiche, sans remplissage interne.
L'échelle (scale) Minimum/Maximum
définit les niveaux de zoom auxquels
les couches sont visibles. La coche
"Visible" vous permet de ne plus
afficher la couche d'un thème sans la
supprimer de la liste des thèmes.
Dans cet exemple, les objets de cette
couche deviendront visibles quand
l'échelle est égale ou plus grande que
1:15840 et que la surface de l'objet
(attribut "ACRES") est supérieure à 5
acres.



L'onglet de rendu "Renderer" est
utilisé pour créer des cartes
thématiques, où le rendu de chaque
objet varie suivant les valeurs de ses
attributs (différentes couleurs,
largeur de trait, étiquettes, motif de
remplissage, etc...). Voyez le pdf
d'aide de la visionneuse de TatukGIS
pour les détails.

L'onglet centrale sera nommé "Area"
pour des objets surfacique, "Line"
pour les objets linéaires, ou "Marker"
("marqueur") pour les objets
ponctuels. Les sous-onglets sont
utilisés pour définir la couleur, la
largeur de trait, le motif (remplissage
ou répétition le long de la ligne) d'un
objet vecteur.
Si vous souhaitez voir au travers
d'un objet surfacique,
positionnez "Pattern" à
"TRANSPARENT". Vous pouvez
définir une transparence partielle
dans l'onglet "Layer".
Validez la coche inférieure "Include in
legend" pour que la représentation
du thème apparaisse dans la légende
sous le nom du thème.
Il y a deux manières d'ajouter des
symboles à vos cartes.

Pour un besoin régulier, vous pouvez
créer un thème ponctuel, positionner
des points sur la carte, et puis choisir
un symbole dans une police (Font) ou
un symbole image (bitmap) par le
bouton indiqué (à gauche).
L'autre manière, à réserver pour un
besoin particulier, est d'exporter une
image de votre carte fGIS dans un
programme où vous pouvez
également ajouter des légendes et
des annotations. (la fonction de
dessin dans Microsoft Word® est
utile pour annoter des cartes. Zoner
Draw 3 et AutoRealm sont des
programmes de dessin libres pouvant
également être intéressants.)



L'onglet "Label" d'étiquettage offre
beaucoup d'options pour définir
l'aspect et le positionnement des
textes. Choisissez un champ dans la
liste déroulante (liste des attributs de
l'objet) pour l'utiliser pour étiquetter
vos objets.
Les étiquettes peuvent utiliser plus
qu'un attribut et être sur plusieurs
lignes. L'exemple suivant dans le
champ "Field", énumérera le numéro
de stand, le type principal de bois de
construction, et (sur la deuxième
rangée) le type secondaire de bois de
construction :

:#<:STAND>,
<:PRIM_TYPE>\n<:SEC_TYPE>

Le texte à l'intérieur du parenthèsage
par '<' et '>' (par exemple, <
:STAND >) sont des noms d'attribut
du modèle des données de l'objet.
Voyez le pdf d'aide de la visionneuse
de TatukGIS pour des détails
complémentaires.

L'onglet "Chart" (diagramme) peut
être employé pour créer un
histogramme (camembert ou barres)
basé sur les attributs d'un objet.
Voyez le pdf d'aide de la visionneuse
de TatukGIS pour les détails (environ
1.4 Mo? ; exige un accès Internet).



• Le menu propriétés des thèmes images a deux onglets : .

Si vous avez deux images, vous pouvez les mélanger, par exemple, en les chargeant
toutes les deux dans fGIS et en réglant la transparence, le contraste, etc. de l'image
mise au dessus. Voici un exemple avec une photo aérienne en niveau de gris du côté
gauche, mélangé avec une carte d'altitude en couleur (avec la gamme rouge/orange
pour les altitudes les plus élevées) du côté droit. Cette combinaison a été réalisée
avec les propriétés layer/pixel montrés ci-dessous.

Comme dans l'onglet "Layer" pour un
thème vectoriel, vous pouvez
indiquer une échelle
minimum/maximum à laquelle le
thème sera rendu visible. Vous
devrez tester différentes valeurs de
'Transparency' et 'Addition' pour
obtenir le meilleur résultat.

L'onglet Pixel fournit plus de
paramétrages comme indiqué ici,
permettant l'ajustement fin des
images.



  

3D Utility Example

La visionneuse 3d peut être consultée à partir du menu Utilitaires.
Le visionnement d'une carte en 3d requiert deux fichiers : un modèle numérique du terrain
(Digital Terrain Model ou DTM) qui fournit les altitudes et une image de recouvrement. Le
DTM peut être également regardé seul, en jouant avec la nuance des couleurs.
La technique de base pour employer l'utilitaire implique de créer un DTM et des fichiers de
recouvrement avec les mêmes limites. Il n'est pas strictement nécessaire que les deux
fichiers partagent la même projection puisque la visionneuse 3d ne met pas en référence
des coordonnées spatiales.
Les instructions pour créer les fichiers, suivant deux méthodes différentes, sont décrites ci-
après.

Méthode A: USGS Digital Elevation Model (DEM) et image de
recouvrement issue de fGIS.

1. Cette vue 3d a été faite en combinant un modèle d'altitude d'USGS 30-meter Numérique
(DEM) et une image de recouvrement exportée de fGIS. Bien que l'USGS DEM emploie un
système UTM/nad 27 et que l'image de recouvrement de fGIS ait des coordonnées
WTM/nad 83, les deux couches s'alignent correctement si les limites se superposent.



2. Cette image ci-dessus montre une vue dans l'outil fGIS qui est définie avec les données
utilisées pour le recouvrement d'image. Les lignes jaunes épaisses proviennent d'un
shapefile d'indexation de carroyage d'USGS. Il a été employé comme un guide de

découpage avec l'outil d'export d'image  de fGIS (choisi dans la barre d'outil et utilisé
avec une résolution de 2x). Enregistrer l'image exportée comme un fichier BMP pour
l'employer comme fichier de recouvrement 3d.

3. Lancer l'utilitaire 3d (Utilitaires>Visualisation 3-D>Lancer la visionneuse 3D). Charger un
modèle de terrain (*.DEM) en navigant pour trouver l'USGS DEM qui correspond à votre



vue. Quand le modèle de terrain sera chargé, vous verrez une simple représentation
d'ombrage comme celle ci-dessus.
Utilisez la souris pour déplacer la vue :
Shift + le bouton gauche de la souris soulèvera ou abaissera le paysage.
Ctrl + le bouton gauche de la souris tournera la vue autour de l'axe y.
Alt + le bouton gauche de la souris tournera autour de l'axe x ou de l'axe z.
Le bouton gauche de la souris étant enfoncé, déplacer la souris vers ou loin de vous pour
zoomer ou dézoomer
 
4. Appliquez maintenant l'image de recouvrement (sauvegardée à l'étape 2) pour faire une
carte 3d. La couche orthophoto a été masquée mais les thèmes vecteurs ont été gardés
pour obtenir le recouvrement suivant.

L'interface de la visionneuse 3d (partiellement décrite ci-dessus) offre beaucoup de
possibilités d'ajustements de la couleur de terrain, de l'éclairage, de la taille d'image, etc.
Essayez les pour les tester.
Noter que les données utilisées dans cet exemple peuvent être téléchargées dans le fichier
exemple State_Park.zip (qui inclut le DEM).
Un fichier de carroyage des Etats-Unis en coordonnées géographiques et un fichier de
carroyage du Wisconsin en WTM peuvent être téléchargés sur le site de Digital Grove pour
vous aider à définir les limites de vos images de recouvrement. Référez-vous à la page de
liens de Digital Grove.



Méthode B: Exporter la vue fGIS en 3D

L'utilitaire Visualisation 3D inclut l'outil ci-dessus Exporter la vue en 3D qui exportera le
DTM et les fichiers de recouvrement avec des limites identiques. Il exige qu'une couche
d'image de DTM soit chargée dans la vue de fGIS. Il est préconisé d'utiliser une image DTM
TIF relativement petite (600 à 800 Pixel de large par exemple). La visionneuse 3D gère mal
les images de plus d'un million de Pixels carrés. La résolution de l'image peut être amplifiée,
un facteur 2x est souvent suffisant.

La visionneuse 3D et l'utilitaire d'exportation peuvent ne pas fonctionner de manière
cohérente. Utiliser le avec précaution pour des prises de décision sensible.

Note: Vous pouvez aussi vouloir utiliser ces outils avec 3DEM or LandSerf. La procédure est
alors un petit peu plus complexe mais ils offrent des fonctionnalités additionnelles comme le
support GPS et l'animation d'images.



  

Créateur de diagramme - module de mise en page de fGIS
 
Quand vous utilisez l'export d'image proposé par fGIS, vous avez la possibilité d'ouvrir
l'image dans le concepteur de diagramme.

Le créateur de diagramme est un module d'illustration technique et de mise en page. Le
programme offre la possibilité d'ajouter les informations descriptives aux cartes telles que
des en-têtes, des légendes, des logos et des symboles non-spatiaux.  Quelques uns des
points forts du module créateur de diagramme sont listés ci-après:

1.  Des cartes peuvent être annotées avec une collection d'objets géométriques, des textes
et des symboles stockés dans des palettes de formes. La palette active peut être changée
par clic-droit sur la palette et navigation jusqu'à la palette que vous voulez utiliser. Vos
objets vectoriels, images et groupes d'objets peuvent être sauvegardés dans les palettes.
Quelques palettes de symbole par défaut sont incluses dans la distribution de fGIS.
2.  Le contenu de la page peut être distribué dans quatre couches séparées, permettant
d'ajouter, déplacer ou éditer des caractéristiques d'une couche sans modification
accidentelle des informations dans les couches sous-jacentes. Un en-tête et une carte, par
exemple, peuvent être placés dans une couche et le texte ou les symboles globaux dans
d'autres couches.
3.  Les utilisateurs peuvent créer leurs propres palettes des symboles fréquemment utilisés
ou d'autres objets. Créez vos symboles simplement dans une page et puis stockez cette
combinaison dans une palette et sauvegardez-la.
4.  Le module créateur de diagramme offre beaucoup d'options de formatage des textes (y
compris indice supérieur et indice inférieur). En enregistrant le texte en métafichier
(metafile), il peut être tourné ou redimensionné.
5.  Les projets permettent de définir des tailles de page personnalisables de toutes
dimensions, ou le module de diagramme peut récupérer la taille de page indiquée par la
configuration de l'imprimante. Envoyez le projet à votre imprimante ou sauvegardez-le dans
un des nombreux formats de fichiers de vecteur ou d'image proposés.



Comme illustré dans la représentation ci-dessus, fGIS adapte l'image de carte à la largeur
de la page défini dans le module créateur de diagramme. L'image est placée sur la couche
"Global Stencil". Vous devrez éditer cette couche (Diagram>Edit layer>Global stencil)
pour déplacer ou redimensionner la carte. Basculez de nouveau sur les couches 1, 2 ou 3
pour ajouter ou éditer le texte et les symboles (en gardant différents objets sur des couches
séparées, vous pouvez facilement les déplacer sans modifier autre chose par inadvertance.)

Notez que si vous voulez voir chacune des quatre couches simultanément, rendez-les toutes
visibles avec la commande File>Preview Mode. Sinon, seulement la couche "Global
Stencil" et la couche active seront visibles.  

Étapes pour imprimer une carte du Wisconsin MFL à 8 pouces au mile

1. Dans fGIS, zoomer dans la section de PLSS que vous
avez l'intention d'imprimer. Remplissez la vue avec la
section (la résolution de l'écran recommandée est 1024
x 768).
2. Désélectionner tous les thèmes vecteurs et images
que vous ne voulez pas imprimer (décocher les).

3. Cliquer sur l'outil Export Image:
 
4. Tirez un rectangle englobant de la section de PLSS
que vous voulez imprimer (tracer un rectangle vers le
bas en tirant sur la droite avec votre souris en
maintenant le bouton gauche enfoncé. Relacher le
bouton gauche une fois la sélection terminée). Placez le
rectangle de sélection à quelques Pixels en dehors des
lignes de section afin de capturer les lignes de section
en tant qu'élément de l'image.
 



5. Après avoir tiré un rectangle englobant, la boîte de dialogue suivante, demandant la
résolution, s'ouvrira. Augmenter la résolution de l'image par 2. Moins de 2 pourraient avoir
comme conséquence des lignes en dents de scie.

6. Cliquer OK et enregistrer l'image en PNG (Portable Networks Graphic). Donner un nom au
fichier et enregistrer le dans le répertoire approprié.(Les fichiers PNG sont relativement
petits)
7. Cliquer Yes pour ouvrir le Créateur de Diagramme et pour utiliser le modèle de carte
MFL:

Donner un nom à votre diagramme, enregistrer le et ouvrer le.
8. Vous verrez l'image exportée dans le Créateur de diagramme mais elle doit être trop
petite. Pour changer la taille et la position de l'image vous aurez besoin d'utiliser le menu
"Global stencil". Pour le lancer aller dans Diagram>Edit Layer>Global Stencil.

9. Changer le niveau de zoom du Créateur de diagramme à 50% afin de voir toute la
page (utiliser l'outil zoom sur la barre d'outils).
 

Cliquer sur l'outil de sélection :
 
Faire un clic-gauche sur l'image pour la sélectionner puis faire un clic-droit et lancer la page
de propriétés.



Dans la page de propriétés, changer la largeur et la hauteur à 8 pouces. (Si vous ne l'avez
pas déjà fait changer l'unité du Créateur de diagramme en pouces en allant dans le menu
File>Options =>Units).
Note : si votre section de PLSS n'est pas vraiment à angle droit vous pouvez placer la
hauteur à une valeur plus appropriée plus grande ou moins grandes que huit pouces, mais
gardez la largeur à huit (Vous pouvez déterminer les proportions correctes entre la hauteur

et la largeur en utilisant l'outil Mesure dans fGIS. Cliquer OK et utiliser la souris pour
centrer l'image sur la carte MFL.
10. Utiliser le menu Diagram>Edit Layer>Layer 1 pour changer et éditer la couche 1.
(cela vous empêchera de déplacer par distraction l'image une fois que vous l'avez placée
correctement). Cliquer sur l'icone Enregister.
Sélectionner une flèche, le symbole de l'échelle d'une carte ou d'autres symboles et
marques d'annotation de la palette de symboles sur le côté droit du Créateur de
diagramme. Les objets peuvent être redimmensionnés ou tournés en tirant les "poignées"
des objets choisis ou par clic-droit en changeant leurs propriétés.

11. Pour éditer l'entête du document MFL, zoomer au niveau de l'entête, faire un clic-
gauche sur le texte qu'on désire changer et appuyer sur la touche F2 pour ouvrir la boîte de
dialogue d'édition du texte :

 
The first part of the text string is formatting codes. In the above example, the font is set as
bold, 12 point (\B\12). If you don't specify a font, Arial 10 pt. is the default. The text MFL
number follows a space. Click OK to accept the changes.
La première partie de la chaîne du texte est le code de formatage. Dans l'exemple ci-
dessus, la police est en "gras", à12 points (\B\12). Si vous n'indiquez pas une police, Arial
10 points est utilisé par défaut. Puis suit un espace. Pour accepter les changements cliquer
sur OK. Le texte peut inclure une combinaison de formatage de type habituel.
12. Une fois que tout est bien positionné et que le texte est correcte utiliser File>Print
pour produire le fichier de sortie. enregister votre fichier diagramme.



  

Tutorial sur l'édition des polygones

Index:
A. Couper les polygones à l'aide de l'outil Scinder l'entité
B. Joindre les polygones en utilisant la commande Soustraire le polygone
C. Créer des polygones à trous et supprimer les trous des polygones
D. Découper les polygones en utilisant la commande Découper avec le polygone
E. Créer des polygones qui sont dans d'autres polygones
 

A.  Couper les polygones à l'aide de l'outil Scinder l'entité

L'outil Scinder l'entité est utilisé pour couper des polygones en polygones plus petits. 
Dans l'exemple suivant, le polygone vert "PR" sera découper en deux polygones à l'aide de
l'outil Scinder l'entité.

1. Aller dans Edition - Mise à jour pour lancer le mode mise à jour du thème.

2. Cliquer sur l'outil Scinder l'entité .
3. Tracer une ligne de découpe dont les extrémités sont à l'extérieur du polygone à

découper, comme montré ci-après.



4. Double-cliquer sur la ligne de découpe à l'extérieur du polygone à découper et le
polygone est scindé en deux parties.

5. Vous pouvez voir ci-dessous le résultat de la découpe d'un polygone avec l'outil
Scinder l'entité. Noter que les attributs des polygones créés sont ceux du polygone
à découper, ils ont été copiés. Les étiquettes des nouveaux polygones ont été mises
à jour.



B.  Joindre les polygones en utilisant la commande Soustraire le polygone

Lorsque vous tracez des polygones les uns à côtés des autres, il est souvent plus
facile d'ajouter un nouveau polygone en utilisant la commande Soustraire le
polygone que d'essayer de superposer les sommets du nouveau polygone sur les
sommets des polygones existants.

Dans l'exemple suivant, le polygone rouge "R" sera ajouté aux autres polygones
adjacents en utilisant la commande Soustraire le polygone.

1. Aller dans Edition - Mise à jour pour lancer le mode mise à jour du thème.

2. Utiliser l'outil Créer une entité , tracer un nouveau polygone qui recouvre les
bords des polygones vert et bleu comme montré ci-dessous, pour terminer le
polygone faire un clic droit, fermer la forme.



3. Avec l'outil Sélection sélectionner le polygone à soustraire aux autres, ici le
polygone qu'on vient de créer.
Note:  Le polygone est sélectionné quand chacun de ses sommets est
numéroté et en vert.

4. Lancer la commande Edition - Fonctions sur les Polygones - Soustraire les
Polygones (ou clic droit de la souris) afin de soustraire du polygone sélectionné les
zones intersectant avec les polygones adjacents (bleu et vert).

5. Le résultat de cette action est visible ci-après. Le polygone rouge "A" a été modifié
pour que ses contours coincident avec celles des polygones adjacents.



C.  Créer des polygones à trous et supprimer les trous des polygones

Quelques fois il est nécessaires de créer ou de supprimer des trous dans les
polygones comme ceux ci-dessous.

 
Le polygone vert "PR" contient un trou.

Pour ajouter un trou à un polygone, utiliser la procédure suivante :

1. Aller dans Edition - Mise à jour pour lancer le mode mise à jour du thème.
2. Selectionner le polygone auquel vous voulez ajouter un trou en utilisant l'outil

Editer les points/Sélectionner . Un clic droit dans le polygone évite de bouger les
sommets et permet la sélection.
Note:  Le polygone est sélectionné quand chacun de ses sommets est
numéroté.

3. Lors du clic droit dans le polygone pour le sélectionné un menu s'ouvre, lancer la
commande Fonctions sur les Polygones - Ajouter le morceau (ou fusionner). 
Note:  la commande Fonctions sur les Polygones - Ajouter le morceau (ou
fusionner) n'est disponible que dans le menu contextuel du clic droit de la
souris, pas dans le menu Edition.



4. Tracer les contours du trou.
Note:  Placer, de préférence, les sommets du trou dans le sens des aiguille
d'une montre sinon vous devrez utiliser la fonction Fixer le sens
d'enroulement du polygone.

5. Puis clic droit - fermer la forme.
6. Si le trou n'apparaît pas lorsque vous le tracez, assurez vous que le polygone est

toujours sélectionné et lancer la commande Fonctions sur les Polygones -Fixer le
sens d'enroulement du polygone.

 

Pour enlever un trou d'un polygone, utiliser la procédure suivante :

1. Aller dans Edition - Mise à jour pour lancer le mode mise à jour du thème.
2. Selectionner les sommets du trou à oter en utilisant l'outil Editer les

points/Sélectionner . Un clic droit sur un des sommets du trou à sélectionner
évite de bouger les sommets et permet la sélection.
Note:  Le trou est sélectionné quand chacun de ses sommets est numéroté
et en vert.

 
3. Une fois que le trou est sélectionné lancer la commande Fonctions sur les

Polygones - Supprimer le morcellement pour enlever le trou du polygone.
 



D. Découper les polygones en utilisant la commande Découper avec le polygone

Quand vous traçez des polygones sur des polygones existants il est plus facile
d'insérer le nouveau polygone en utilisant la fonction Découper avec le Polygone
plutôt que d'essayer de superposer les sommets du nouveau polygone sur les
sommets des polygones existants.

Note: La fonction Découper avec le Polygone n'est utilisable qu'avec des
polygones dont les contours coupents les polygones qu'ils recouvrent. Pour
découper un polygone entièrement contenu dans un autre polygone, créer
d'abord un trou dans le polygone contenant puis introduire un nouveau
polygone dans le trou.

Dans l'exemple suivant, le polygone rouge "A" sera inséré en utilisant la fonction
Découper avec le Polygone qui découpera les contours des polygones adjacents.

1. Aller dans Edition - Mise à jour pour lancer le mode mise à jour du thème.

2. Utiliser l'outil Créer une entité , tracer un nouveau polygone qui recouvre les
bords des polygones vert,bleu, marron et orange comme montré ci-dessous.
NOTE:  Ne double-cliquer pas sur le dernier sommet du nouveau polygone
pour fermer la forme, sinon il deviendra difficile de sélectionner le polygone
car il recouvre d'autres polygones.



1. Lancer la commande Edition - Fonctions sur les Polygones - Découper avec le
Polygone pour couper les polygones adjacents au polygone sélectionné suivant les
contours du polygone sélectionné.

2. Le résultat de cette commande a modifié les contours des polygones 'PR', 'Grass', 'O'
et le polygone bleu.



E. Créer des polygones qui sont dans d'autres polygones

La commande Découper avec le Polygone ne peut pas être utilisée lorqu'un
polygone est entièrement dans un autre polygone.

Pour effectuer cette manipulation il faut respecter la procédure suivante :

1. Premièrement créer un trou dans le polygone sous-jacent, qui est la forme du
polygone que vous voulez créer en utilisant la procédure C-Créer des polygones à
trous et supprimer les trous des polygones.

2. Choisissez dans la liste déroulante la couche approprié pour permettre le calage par
capture.

 

3. Puis utiliser l'outil Créer une entité pour tracer un nouveau polygone et caler
ses sommets dans le trou créé précédemment.



 



  

Trouver des données de fonds pour fGIS

Pour commencer une carte dans fGIS, vous devez charger au moins un thème de fonds (une
photo aérienne géo-référencée, une carte scannée ou toute couche géo-référencée de
vecteur). Tous les thèmes dans un projet doivent également être dans une projection
cartographique avec des datums uniformes. Alors, où obtenir de telles données de fonds pour
démarrer un projet?

Si vous êtes un forestier du Wisconsin, des jeux de données normalisés sont fournis par le
spécialiste en sylviculture de DNR.

Pour d'autres utilisateurs nord-américains, l'approche la plus simple pour obtenir les photos
aériennes et les données vectorielles dans une projection uniforme pourrait être de
commencer par les images du TerraServer et les données en ligne US Census TIGER.

• TerraServerUSA est une excellente source de photographies aériennes et de cartes
topographiques USGS. Les programmes gratuits USAPhotoMaps et MapShots
TerraFetch® permettent de rechercher des images du TerraServer et de les
sauvegarder en images géoréférencées (UTM-NAD83  ) pour les charger dans fGIS.

• L'US Census TIGER fournit en ligne les frontières politiques, routes, rivières, surfaces
d'eau, etc., en plus des attributs démographiques. Ces données sont fournies par
beaucoup de sources, y compris ESRI® ou MapShots®. Si les données de base sont
en coordonnées géographiques (lat/lon WGS84), ce qui est généralement le cas, elles
peuvent être converties en système UTM-NAD83 avec l'utilitaire de projection de
fichiers Shapefile inclus dans fGIS.

La plupart des départements de conservation d'Etat offrent des données libres ou à un coût
minimal. Vous pouvez employer un moteur de recherche d'Internet pour rechercher des
données SIG pour votre zone; par exemple, le moteur Google pour rechercher " données SIG
de l'Alabama", "données spatiales de la Californie", etc... Recherchez " données libres SIG" et
vous serez étonnés du nombre de réponses. Il y a également beaucoup de fournisseurs
commerciaux de données spatiales (par exemple, MapMart, GeoCommunity, etc...)

Les données publiques du système "Public Land Survey System" (PLSS) peuvent être
particulièrement utiles aux directeurs de ressource qui doivent identifier des limites de
propriété. Beaucoup d'agences de ressource d'Etats fournissent des données PLSS. Le bureau
"US Bureau of Land Management offre des données PLSS pour beaucoup d'Etats. Vous
pourriez également rechercher des données PLSS pour votre zone avec Google. Voir webGIS
pour des données au format shapefile issues des cartes de carroyage d'USGS.

fGIS n'ouvre pas directement des données de MNT (modèle numérique de terrain, indiquant
l'altitude) pour obtenir des cartes 3D. Vous pouvez, cependant, produire des images
ombragées en fonction de l'altitude par le programme gratuit 3DEM, qui constitue un
excellent complément à fGIS. 3DEM génère des images ombragés en fonction du relief en tant
que fichiers images géo-référencés, qui peuvent être facilement ajoutés en tant que thème
dans fGIS.
Un certain nombre de sources pour des données libres d'altitude sont listés dans les liens de
Digital Grove.
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Additional copyrights related to fGIS components apply as follows:
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SHPTRANS - Shapefile coordinate transformation utility version 1.1c-pre2.
Copyright (c) 1999-2003 Bruce Dodson and others. All rights reserved.
This software is protected by copyright law and is made available
under the following license. The copyright holders do not intend
for these license terms to form a contractual agreement.
SHPTRANS License 1.1:
SHPTRANS is Copyright (c) 1999-2003 Bruce Dodson and others.
All rights reserved.
Permission to use, copy, modify, merge, publish, perform,
distribute, sublicense, and/or sell copies of this original work
of authorship (the "Software") and derivative works thereof, is
hereby granted free of charge to any person obtaining a copy of
the Software, subject to the following conditions:
1. A copy of this license (including the above copyright notice,
this permission notice, and the following disclaimers) must
appear in the documentation or in other materials accompanying
the Software, where an end-user can reasonably be expected to
see it.



2. The above copyright notice must appear in all copies of the
Software and in any portions thereof. The copyright notice
must be followed immediately by a notice stating that the
Software is made available under the terms of this license,
and indicating where the complete license text is found.
3. Products derived from the Software must include the following
notice in their documentation or in other materials accompanying
the work, where an end-user can reasonably be expected to see it:
"Portions of this software are based on SHPTRANS by Bruce Dodson."
4. The names of the copyright holders and contributing authors may
not be used to endorse or promote products derived from the
Software without specific prior written permission.

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND.
THE COPYRIGHT HOLDERS AND CONTRIBUTING AUTHORS DISCLAIM ANY AND
ALL WARRANTIES, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTING AUTHORS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING IN ANY WAY OUT OF THE USE
OR DISTRIBUTION OF THE SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

End of SHPTRANS License
----------------------------------

NTv2 Support:
Support for Canadian NTv2 datum conversion as implemented in SHPTRANS
was originally based on a program called NADCONV, which was published
as part of the Open Geographic Datastore Interface (OGDI) project.
The source code for NADCONV was licensed under the following terms:

Copyright (c) 1996 Her Majesty the Queen in Right of Canada.

Permission to use, copy, modify and distribute this software and
its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all
copies, that both the copyright notice and this permission notice
appear in supporting documentation, and that the name of Her
Majesty the Queen in Right of Canada not be used in advertising
or publicity pertaining to distribution of the software without
specific, written prior permission. Her Majesty the Queen in Right
of Canada makes no representations about the suitability of this
software for any purpose. It is provided "as is" without express
or implied warranty.
The original source code for NADCONV has been enhanced in accordance
with those terms. The enhancements are part of SHPTRANS, and are
Copyright (c) 1999-2003 by Bruce Dodson.
In order to exercise rights in SHPTRANS, or in any other work that
incorporates the SHPTRANS implementation of NTv2, you must do so in a
manner that satisfies the conditions of both the NADCONV permission
notice and the SHPTRANS license.
---------------------
See the fGIS System folder for additional information about Diagram Designer and Convert.



  

fGIS Revision History
June 28, 2005
1. Bug Fix: the Utilities > Join Access Table to Shapefile dialog would only allow the fields
from the first table in the database to be used in the join. Now any field from any table in
the database can be used.
2. Bug Fix: the Layer > Load .ini File command was not loading legend text properly.
3. The default installation directory for "fGIS_setup.exe" has been changed to
"C:\DNRAPPS" to accommodate Wisconsin DNR users. If you prefer another location such as
"Program Files", then type in an alternate folder name in the setup dialog.
4. Updated the Help file to suggest using HyperCube from the US Army Corps of Engineers
for image warping and georeferencing in combination with fGIS.
 
May 10, 2005
1. Added the Utilities > Merge Shapefiles dialog. This dialog can be used to merge
multiple shapefiles into a new one. All fields from all input layers will be included in the
output shapefile.
2. The Map > New Layer command now includes the New Shapefile Field Manager dialog
to retrieve default attribute table settings. These settings are stored in a file named fgis.ini
that is stored in the same directory as fGIS.exe. The New Shapefile Field Manager dialog
can also be accessed from the Utilities > New Shapefile Field Manager command. An
example fGIS.ini file to be used with the New Shapefile Field Manager is included (open it in
Notepad or other text editor).
3. Added the Utilities > Clip Shapefiles dialog. Use this dialog to clip line or polygon
layers to the boundaries of a polygon layer.
Point layers can NOT be clipped using this dialog. To clip out point layers, select the points
using the Map > Spatial Selection dialog, then create a new shapefile of the selected points
using the Layer > Export Layer dialog.
4. Added the Utilities > Repath Project File dialog. This dialog is useful for modifying a
project file after data, projects, or directories have been moved.
5. Added WMF export capability to the Map > Export View to Image dialog. Note that
WMF graphics can only be exported at screen resolution. The vector layers in WMF images
can be resized without loss of quality in drawing programs. WMF images are not
georeferenced.
6. An Access table join (created via the Utilities > Join Access Table to Shapefile dialog) can
be saved to and reloaded from the project file.
7. Addition in the Load Library Layer dialog: When a new Env file is selected with the Env >
Set Env File command and the project is saved, the new Env file name will be saved to a file
named fgis.ini and used as the default Env file.
In the Load Library Layer dialog, layer display names can be specified in a field named
"Alias" in the layer table, however the names stored in a .ini file will take precedence.
8. Added the "Increase Output Feature Size by" functionality to the Map > Send Map to
Word dialog.
9. Bug fix: the Edit > Paste Shape command did not work if there were no other shapes in
the shapefile.
10. The Import XY Table to Shapefile dialog now adds the new shapefile to the view after
creating it.
11. The Map > Print Map dialog now includes a "white legend" checkbox that changes the
Legend to white so that the background of legend icons prints white.
12. Bug fix: The Layer > Load .ini File command would only load the first legend item. Now
it should load all.
13. Added the Minimize Window checkbox to the Search dialog.



14. The Map > Set Default Data Directory command was added. This command will set
the first directory that fGIS look to for data, rather than the fGIS installation directory.
15. Updated language.ini.
 
April 7, 2005
1. Added the Layer > Copy Selected Shape and Edit > Paste Shape commands (also
available from the View's right-mouse-click popup menu) so that shapes can be copied from
other layers to the layer being edited. Line objects can only be pasted into line layers,
polygon objects into area layers, etc. The shape is copied in WKT (Well-Known Text) format
so that users could create or edit a shape in a text editor and paste it directly into the layer.
To see the format, copy the shape and paste into a text editor.

2. Added Chains to status bar when using the Measure tool. (Chains are a standard land
survey measurement. One Chain = 66 feet; 80 Chains = 1 Mile)

3. Added the Map > Bookmarks command. Multiple named bookmarks can be utilized and
saved to the project file.

4. Added all UTM zones to the Lat./Lon. to WTM (Wisconsin Transverse Mercator) form. UTM
users can modify the language.ini to display "UTM" text instead of WTM, or to place their
UTM zone at the top of the projection list. Also added two checkboxes to add "-" signs to
the input coordinates to designate southern and western hemispheres. (Longitude should be
set to negative for users in Wisconsin and elsewhere in the US.)

5. The WTM location to Lat./Lon. command (from the view's right-mouse-click popup menu)
will now utilize whatever projection is selected in the Lat./Lon. to WTM form (WTM or any
UTM zone). Again, UTM users can modify the language.ini to display "UTM" text instead of
WTM, or to place their UTM zone at the top of the projection list.

6. Added the Search for Township/Range/Section dialog to the Utilities menu. Requires that
an appropriate Public Land Survey System layer is loaded.

7. Added the Layer > Load .ini file command. This command enables layer properties saved
to an .ini file to be used for another layer. Users could create a library of .ini files and load
them as new layers are created.

8. Added the Map > Selection submenu. The Selection Color command allows the selection
color to be changed. The Selection Transparency sets the transparency of the selection
color. Both settings are saved to the project file.

9. Updated the Utilities > 3-D Viewing > Export View to 3-D dialog to only output four
standard image widths. The 3-D viewer software does not operate properly unless the input
image width has an even number of pixels. Also, the 3-D viewer software locks-up if the
input image is too large.

10. Updated the Map > Export View to Image command to include a dialog and additional
options. By increasing the output image size, multiple images in the view can be put into a
mosaic. Output image size can also be increased if the view is intended for printing in a
publication. Increasing the output feature size will increase the size of labels, points, and
lines in the output image.

11. The Remove All and Load .ini File buttons were added to the Image Catalog utility.

12. The Import XY Text Table to Shapefile dialog can now convert tab-delimited text tables
to shapefiles.

13. Bug fix: The Traverse dialog was incorrectly computing bearings when a N/S degrees
E/W bearing was input.



14. Modified the Layer > Save Layer Properties to .ini File command to prompt for the .ini
file location. The default location is the location of the layer. This makes it easier to create
libraries of layer.ini files, or to create a layer.ini file for a file in a read-only directory.

15. Bug fix: The Map > Save Project As command would not function if the original project
file was Read-only. This should make it easier to modify projects in Read-only directories or
CDs.

16. Bug fix: The "Increase output feature size" listbox from the Export View to 3-D dialog
wasn't working properly.

17. Created a dialog for the Map > Send Map to Word command.

18. Created a dialog for the Export Image tool.

19. Added the Utilities > Routing Utility: The Routing Utility will locate addresses (using the
From text and the Find Address button) and find the best route between two addresses
(using the Find Route button) in the Routing Layer. The Routing Layer is typically a Road
shapefile based upon the US TIGER roads data. Such a layer is available in the
State_Park.zip fGIS sample dataset and for WI from the DNR. See dialog for more help.

20. Added the ability to select a different env.txt file instead of the one in the /fgis directory
using the Env > Set Env File command on the Load Library Layer dialog. The default env.txt
file can also be set in the language.ini file.

21. The Load Library Layer dialog will now optionally load an .ini file specified in the
INI_FILE field of the Layer Table. This field can use environment variables for the path.

22. Added the Utilities > Live GPS Utility. This utility will display the GPS location for a GPS
receiver outputting NMEA format data connected to the COM port. The location can
optionally be snapped to a line layer to correct for moving features. This utility has not been
tested with moving GPS receivers. See the dialog for more help.

23. There is now a small "C" button on the Lat/Lon Location to WTM dialog that will convert
the input Lat/Lon to/from DD, DM, or DMS.

24. Updated language.ini.
February 24, 2005
1. Reverted back to the previous shape digitizing mode, again by popular demand. When
digitizing, the next vertex is added to the closest line segment, rather than connected to the
previous vertex. Vertices can be added by clicking on a line segment. Vertices can be
deleted by double-clicking on them. Holding down the <SHIFT> key and digitizing will
attach the next vertex to the previous one.

2. Updated the DXF handling library. It should handle complex files better.

3. Changed the Map > Print Simple Map command to Map > Print Map. The new dialog
includes the previous Simple Map as well as a Template Map printing section, page
orientation, and printer setup functions. A template example is included (print.tpl) for
advanced users who want to design their own. The template files can be edited in Notepad.
(Wisconsin DNR foresters will receive additional print template files from the GIS specialist.)

4. The Map > Overview Map command was added. This displays the Overview Map view.
Using the right-mouse-click popup menu on the Overview Map, a layer can be added and
the extent box color can be changed. The extent box can be used to change the extent of
the main map view by left-clicking and dragging in the Overview Map view. The contents of
the Overview Map are also saved to the project file. The Overview Map can also be used in



the template files (.tpl) used with the Map > Print Map command.

5. Added the 3-D Viewing submenu to the Utilities menu. The 3-D Viewing > Export View to
3-D command displays a dialog that will export a DTM to a TIFF and the view to a BMP so
that they can be viewed in a 3-D viewer program. The 3-D Viewing > Launch 3-D Viewer
command will launch the utility. Note: This feature is in a beta stage and may not work
consistently. The 3D viewer (©Geomantics Ltd.) is distributed with Forestry GIS under
license to the Wisconsin Department of Natural Resources - Division of Forestry.
6. Updated the Traverse tool to utilize N S E W directions.
7. Added Miles to the Traverse dialog for fire lookout tower shots.

8. Added the Hyperlink tool to the Utilities menu. This tool changes the function of the Pick
tool to display the file specified by the filename in the Hyperlink field for the shape selected.
Images, text documents, web pages, etc. can be used.

9. Bug fix: the quarter-quarter description generated by the Lat./Lon. Location to WTM
dialog was reversed.

10. Changed the Measure tool graphic to Red.

11. The Measure tool now displays the distance from the beginning of the measured line to
the cursor location.

12. Updated language.ini.
January 27, 2005

1. The default digitizing mode has changed. The more intuitive "follow" mode is now
available without having to hold down the shift key.  If you hold down the shift key
when digitizing, the next vertex will be inserted into the nearest line or polygon
segment.

2. The Hide command was added to the Layer menu and the Legend popup menu.  This
will merely hide the layer from the legend so that it does not take up so much space
(for multiple base images, etc.). This setting is saved to the project file.

3. The Unhide All Layers command was added to the Map menu.
4. All image layers are added to the bottom of the layer stack.
5. Right-mouse clicking on the legend now selects the layer under the mouse cursor,

and then displays the popup menu.
6. The display coordinates on the lower status bar display more decimal places if

decimal degree data are being used.
7. The status bar turns red when editing a shapefile.
8. New splash screen in About box.
9. By popular demand, the legend remains enabled when a shapefile is being edited.
10. Added Help box for the Traverse dialog.
11. The Add Point button on the Traverse dialog will now add a new point to a point

shapefile relative to the point currently selected with the Edit Points tool (i.e., the
Traverse Tool now works for point, line and polygon objects).

12. Added support for ESRI Grid files (*.adf). This is the DEM format used by Wisconsin
DNR.  These can be colored nicely using the Wizard button on the Layer Properties
dialog.

13. Projects should load faster, because the view goes directly to the saved extent,
rather than the full extent first.

14. The Image Catalog Utility dialog (Utilities > Image Catalog Utility) will load all layers
in an image catalog and optionally hide them all upon loading. The DNR uses image
catalogs to load groups of DRGs. There are also commands to Turn On/Off and
Hide/Unhide all image layers as a group.

15. Rods and Chains have been added to the Traverse window.
16. DMS added to Lat/Lon Location to WTM dialog.
17. The Sort Shapefile button was added to the Join Access Table to Shapefile dialog. 

a. This function will sort the selected shapefile by the selected attribute field and



output it to a new shapefile. The new, sorted shapefile should be added to the
theme (legend or table of contents) in order to take advantage of it for the
Access table join in (b).

b. Access table records are now sorted by the join field prior to creating the
join.  The join works best if there is a one-to-one relationship between the
records in the shapefile and the Access table, AND if the records in each
dataset are sorted by the same field.

18. "Table > Add Field" and "Field > Delete" commands were added to the Shapefile
Table dialog. (You can also add or delete attribute table fields with the Attributes
Tool while in the Edit mode.)

19. Updated the language.ini file.
January 12, 2005

1. Added the utility "Import XY Text Table to Shapefile". This command will create a
point shapefile from a comma delimited text table with XY coordinates in decimal
degree format.

2. Added the utility "Join Access Table to Shapefile". The Join is a "live" join to the
database. The joined fields are visible in the Layer Properties, Attributes Tool, and
Search dialogs.

3. The fGIS help is now in CHM format rather than HTML.
4. Bug fix: If a layer was removed from the view and there was no selected layer in the

legend/table of contents, an error occurred when the user right-mouse clicked in the
view.

5. Measure Tool dialog box text corrected for "Length".
6. The Lat/Lon Location to WTM dialog is now minimized before it places a graphic dot

on the view so that it does not completely cover the graphic dot.
7. Updated the language.ini file.

January 2, 2005
1. Updated the Help System for revisions made to date. (FYI: Significant

additions/changes to fGIS are anticipated in the first quarter of 2005. Plans include
simplified print layout and 3D viewing capabilities among other features under
development.)

 
Oct. 2, 2003 - Initial beta release.


